
 

 

 

CREATIVE OPINIONS 

DIFFERENTIATE 

EDUCATION  

IN MATHS 

 
Magazine No. 1, 2019 

 
 

September 2018 - February 2019 
 

 

 
 



 

 

 

 

 

 

CREATIVE OPINIONS 

DIFFERENTIATE EDUCATION  

IN MATHS 
 

 

Colegiul Tehnic ”Gheorghe Cartianu” 

Piatra-Neamţ, Bd. Traian, no. 31 

Neamt, Romania 

Tel/fax: +40233222800 

E-mail: colegiulcartianu@gmail.com 

 

 

 

 

 

Editors and Authors:  

Horlescu Gabriela-Brândușa, teacher 

Secară Ana-Irina, teacher 

 

 

 
 

ISSN 2668-4276, ISSN-L 2668-4276 

mailto:colegiulcartianu@gmail.com


 

 

Project Title: Creative Opinions Differentiate Education  

In Maths 

Project Acronym: C.O.D.E in Maths 

 

 

 

Main objective of the project: Exchange of Good Practices 

Project Start Date: 01-09-2018 

Project End Date: 31-08-2020 

Project Total Duration: 24 months 

Applicant Organisation: Denizli Erbakir Fen Lisesi, Turkey 

Website: https://codeinmaths.weebly.com 

 

 

 

 

 

Partner Organisations: 

Colegiul Tehnic ”Gheorghe Cartianu”, Romania 

Technikum Informatyki Edukacji Innowacyjnej, Poland 

Istituto Tecnico Settore Tecnologico - Liceo Scientifico "E. Mattei", Italy 

Centro Integrado De Formación Profesional Medina Del Campo, Spain 

 

 

https://codeinmaths.weebly.com/


"The European Commission support for the production of this publication does not 
constitute an endorsement of the contents which reflects the views only of the 
authors, and the Commission cannot be held responsible for any use which may be 

made of the information contained therein." 
  

Page 1 
 

CodeWeek EU 
6th — 21st October 2018 

 

"EU Code Week is a grassroots initiative which aims to bring coding and 

digital literacy to everybody in a fun and engaging way." 

Our event:   codeweek.eu/view/166922/code-in-maths 

In our Erasmus + project - Creative Opinions Differentiate Education In 

Maths - we celebrated "EU Code Week" as it was a great event for our students 

and teachers to bring together people who were motivated to learn.  

The idea was to make programming more visible, to show young people, 

adults and the elderly how we brought ideas to life with coding. We used 

Coding for Young Beginners to develop digital and STEM skills for our 

students. 

 

 

http://codeweek.eu/view/166922/code-in-maths


"The European Commission support for the production of this publication does not 
constitute an endorsement of the contents which reflects the views only of the 
authors, and the Commission cannot be held responsible for any use which may be 

made of the information contained therein." 
  

Page 2 
 

Code Week activities in Turkey 

 

Students from Erbakır Science High school did some workshops by using 

action bound application which was a STEM-based game.They used Scratch to 

create a game that had educational quality and MIT App-inventer to create a 

mobile application which found solutions to the problems we face in our daily 

life. 

 

  

  

 

  

https://codeinmaths.weebly.com/uploads/1/2/2/1/122112933/46370035-10156243260924209-5102069686179201024-n_orig.jpg
https://codeinmaths.weebly.com/uploads/1/2/2/1/122112933/46396482-10156243260664209-3994502142864916480-n_orig.jpg
https://codeinmaths.weebly.com/uploads/1/2/2/1/122112933/46409591-10156243261249209-1358450125105528832-n_orig.jpg
https://codeinmaths.weebly.com/uploads/1/2/2/1/122112933/thumbnail2_orig.jpg
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Code Week activities in Italy 

 

The class 1b of IIS Mattei, Vasto, Italy,  celebrated Europe Code week 

2018 with an activity called "The artist of the platform www.code.org" which 

allowed us to write programs to draw geometric shapes. Later on students  

programmed robots to reproduce geometric designs. The  coordinator teacher 

was Antonella Pellegrini. 

 

 

  

 

  

http://www.code.org/
https://codeinmaths.weebly.com/uploads/1/2/2/1/122112933/img-20181019-wa0022_orig.jpg
https://codeinmaths.weebly.com/uploads/1/2/2/1/122112933/img-20181019-wa0023_orig.jpg
https://codeinmaths.weebly.com/uploads/1/2/2/1/122112933/img-20181019-wa0024_orig.jpg
https://codeinmaths.weebly.com/uploads/1/2/2/1/122112933/img-20181019-wa0025_orig.jpg
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Code Week activities in Romania 

 

Students from "Gheorghe Cartianu" Technical High School used Scratch 

to celebrate CodeWeek.  

https://scratch.mit.edu/projects/editor/?tip_bar=getStarted 

 

  

 

 

https://scratch.mit.edu/projects/editor/?tip_bar=getStarted
https://codeinmaths.weebly.com/uploads/1/2/2/1/122112933/44460241-302935456970966-1350247562203889664-n_orig.jpg
https://codeinmaths.weebly.com/uploads/1/2/2/1/122112933/44467842-444004106128339-246734206024024064-n_orig.jpg
https://codeinmaths.weebly.com/uploads/1/2/2/1/122112933/44500505-267822270537710-3912283317629616128-n_orig.jpg
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Mathematics in Architecture - academic research 

 

Mathematics in Architecture 

Teacher: Daniela Diaconu 

”Gheorghe Cartianu” Technical High School, Romania 

 

 The connection between Mathematics and architecture has persisted since 

old times. Although at the beginning architecture was not a form of art (because 

ancient people wanted just a simple shelter), later it developed due to the need 

of building something pleasant for the eye.  

 People’s imagination and dare have turned architecture from a job into 

the most complex form of art. 

 The great architect Le Corbussier said that ”architecture is an art, an 

emotional phenomenon out of the building matters and beyond them.” 

 The most important building problems can be solved through Geometry. 

All buildings present volumetric mixtures of geometric shapes. The 

mathematical proportions lie at the root of the architecture quality. 

 Ancient and Medieval builders used the geometrical shapes to draw the 

plans of the building on the ground, whereas the mathematical calculations were 

used to measure the component parts of the buildings. 

 Euclidean geometry has a fundamental role in architecture. Along the 

time, the pyramid is present in impressive constructions.  

 Initially the pyramids appeared in the Precolumbian civilizations (Mayan 

or Aztec) and they had terraces for sacrifices, being built with stairs. This 

highlights the architectural representation of a new religious conviction. 

 The Pyramid of the Sun in Teotihuacan (an old Aztec town in Mexico) 

was built in such a way as the Easter part could be oriented exactly towards the 
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sunrise and the sun rays could come down directly on the top of the pyramid at 

12 pm on May 19 and July 25.  

 
  

https://cersipamantromanesc.wordpress.com/2010/03/28/misterele-piramidei-

soarelui-din-mexic/ 

 

 The Egiptian pyramids impress us even today as they have survived 

through their perfection along the time. 

 When it was built, the Lion Pyramid Kheops was the highest 

construction in the world.  

 The Egyptian architects, who were priests as well, built the pyramid so as 

thearea of the isosceles triangle that makes the side face could be equal to the 

area of the square whose side is the height of the pyramid 

 
https://jurnalspiritual.eu/piramida-lui-keops-stiati-ca/ 

 

https://cersipamantromanesc.wordpress.com/2010/03/28/misterele-piramidei-soarelui-din-mexic/
https://cersipamantromanesc.wordpress.com/2010/03/28/misterele-piramidei-soarelui-din-mexic/
https://jurnalspiritual.eu/piramida-lui-keops-stiati-ca/
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 It was the highest construction in the world for more than 43 centuries. 

Initially, it measured 147m in height, the side face was 227m and it has 

2,521,000 m³ of stone. It is built under the angle 54˚ and 54 min. The biggest 

error between the side lengths is under 0.1%. 

 It seems that the Egyptians perfected the structure of the pyramid and had 

large knowledge of Mathematics and Astronomy. Blending science and 

religion, they considered that the two-dimensional and three-dimensional 

geometrical shapes influence the energetic field around them. That is why the 

pyramid has this effect – because of its shape. 

 Even today the pyramid is viewed as one of the strongest architectural 

constructions. Modern architects analyze it from different perspectives so as to 

get spectacular and efficient structures. 

 The Great Pyramid from the Louvre Museum in Paris is an 

impressive construction, made of metal and glass, surrounded by other 3 smaller 

pyramids in the inner courtyard of the Louvre Palace. I.M.Pei is the architect 

who drew the remarkable and innovative structure of the pyramid. It measures 

21m in height. The building has 673 glass panels: 603 are diamond-shaped and 

70 are triangular-shaped.  The bottom measures around 35m². 

 

 
http://www.descoperalocuri.ro/atractii-turistice/muzeul-luvru-arta-capitala-

frantei.html 

  

http://www.descoperalocuri.ro/atractii-turistice/muzeul-luvru-arta-capitala-frantei.html
http://www.descoperalocuri.ro/atractii-turistice/muzeul-luvru-arta-capitala-frantei.html
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We present you some other imagines containing contemporary 

constructions worldwide, having a pyramid as a bottom.  

 

 Walter Pyramid 

 

 

 
https://en.wikipedia.org/wiki/Walter_Pyramid 

’Ryazan Kremlin’ Historic and 

Architectural Complex 

 

 
 

https://www.rbth.com/travel/327249-russian-incredible-

ryazan-kremlin 

 

 Bolz Music Academy in Wisconsin 
 

 
https://www.idealdecor.ro/wp-content/uploads/2015/09/153519dd-79c4-46b4-8c3c-1baa6d80ab16-olbrich-

botanical-gardens-Custom.jpg 

 

 

  

 

  

https://en.wikipedia.org/wiki/Walter_Pyramid
https://www.rbth.com/travel/327249-russian-incredible-ryazan-kremlin
https://www.rbth.com/travel/327249-russian-incredible-ryazan-kremlin
https://www.idealdecor.ro/wp-content/uploads/2015/09/153519dd-79c4-46b4-8c3c-1baa6d80ab16-olbrich-botanical-gardens-Custom.jpg
https://www.idealdecor.ro/wp-content/uploads/2015/09/153519dd-79c4-46b4-8c3c-1baa6d80ab16-olbrich-botanical-gardens-Custom.jpg
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Mathematics in Architecture 

Teacher:  Daniela Pavăl 

The famous monuments of Ancient and Medieval world architecture 

impress through their grandour and balanced shapes. 

All buildings represent combinations of geometrical shapes whose size is 

determined by using the mathematical calculus. The analysis of the ratios 

between the size of the elements and the artistic shapes can offer information 

about their architectural qualities. After studying more monuments of the world 

architecture and keeping in mind the phylosophical doctrine belonging to 

Pythagora, Plato and the neoplatonic scientists regarding the balance of 

architectural works expressed by numbers and ratios, there came up the concept 

that the artistic shape of buildings is due to certain proportions from the 

component parts of the construction. The term proportion in architecture, 

according to the numeric value of the ratio, is an aesthetic category and the 

number, in the ancient scientists’ view, expresses not only the quantity but also 

the quality of the ratio.  

The corroboration of the found numeric ratios with the historical ones 

belonging to the theory of architecture, and their rebuilding according to 

indirect data from the sciences related to the art of construction, led to the 

highlight of a limited number of ratios. There were found arithmetic ratios 

expressed through natural numbers: :  
1

2
;
1

3
 ;  

3

4
. There were also used irrational 

numbers: 
1

√2
  ;  

1

√5
;  

1

√5

2

;  
2

√5−1
or

√5+1

2
 .  The proportion 

1

√2
 expresses the link 

between the value of the square side and its diagonal ( √2 ). The ratios – 
2

√5−1
 𝑜𝑟

√5+1

2
  give the value of the”golden section” – 1,618..., written by Ф 

(from the name of the sculptor Phidias). Practically, the finding of this ratio was 

often replaced by the ratio from integer numbers from Fibonacci’s additive 

string ...
3

5
 ,

5

8
 ,

8

13
 ,

13

21
 , etc.  

These famous proportions were found in the architectural monuments 

through graphic analysis, they themselves representing one side of the aesthetics 

of mathematics, but also ”chainings” of ratios between the sizes of the building 

components, with mutual interpenetrations of similar shapes.  
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The shape of the Egyptian pyramids takes us to 

think about geometry. The great pyramid of 

Cheops resembles a high mountain of 150 m 

which can be seen from a distance of 40 km. This 

was the highest monument on Earth and was 

considered one of the seven wonders of the 

world. This pyramid has a square as its foot and its sides are isosceles triangles.  

 

 

Herodotus found out from the Egyptian architects, which were also priests at 

that time, that the pyramid of Cheops was built in such a way as the area of the 

isosceles triangle which represents a side face is equal to the area of the square 

which would have as a side the height of the pyramid.  

 

    (Fig.1)  The right triangle 

AOC is the meridian semi-profile of 

the pyramid. We note with a the 

height of the pyramid, with b the 

length of the apotheosis of the 

pyramid and with 2c the length of 

the side of the square from its foot.  

 

From what the Egyptian priest confessed, it results that 𝑏 ∙ 𝑐 =  𝑎2(1), meaning 

that the area of the side isosceles triangle equals the area of the square with the 

side a. This shows that the height of the pyramid is mean proportional between 

two of the sides of the meridian triangle sides of the pyramid: b and c. 

Because the triangle AOC is right, from the Pythagorean theorem results that 

𝑏2 = 𝑏 ∙ 𝑐 + 𝑐2.  
Deviding by 𝑐2, the relation becomes:  

(
𝑏

𝑐
)

2

−
𝑏

𝑐
− 1 = 0 (3). 

 

The problem can be seen from a more general point of view, namely: 

being given a segment of a line AB (fig.2) we can divide it in two unequal parts 

AC and  CB (AC>CB), so as ”the full segment can be reported to the bigger 

segment the same way as the big segment reports itself to the small one”. This 

division of a segment was called by Euclid ”split into mean and extreme ratio” 
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and now it is called ”the golden ratio”. The golden ratio is an irrational number 

that verifies the relation  
𝑏+𝑐

𝑐
=

𝑏

𝑐
 =𝜑, where b and c represent the two parts of 

the initial segment. Thus results that 𝜑 is the solution of the equation φ2 − φ − 1 

= 0, meaning𝜑 =
1+√5

2
≈ 1,6180339887 . ..  . 

Many artists and architects proportioned their works according to the 

golden ratio, considering that this offers a pleasant aesthetic to their buildings. 

The two sides of the meridian triangle of the pyramid of Cheops represent two 

segments which are in the golden cut.  

This cutting can be done with the ruler and the compass (fig.2). We draw 

the given segment AB=a and raise the perpendicular BD from B on AB so as 

BD=AB=a. 

   We build the tangent circle in B at AB, having the diameter [𝐵𝐷] and the 

center O. As we know from the theorem of the power of a point against a circle, 

the secant AO determines on the circle the points E and F, so that 𝐴𝐵2 = 𝐴𝐸 ∙
𝐴𝐹. 

          Building the segments AE =AC și AG =AF, the above relation can be 

written as follows: 𝐴𝐵2 = 𝐴𝐶 ∙ 𝐴𝐺 ⇔
𝐴𝐵

𝐴𝐶
=

𝐴𝐺

𝐴𝐵
=

𝐴𝐶+𝐴𝐵

𝐴𝐵
=

𝐴𝐶

𝐶𝐵
 (4) , meaning

𝐴𝐵

𝐴𝐶
=

𝐴𝐶

𝐶𝐵
  (5) 

In conclusion, the building of the segment AC is done by taking the circle 

tangently into B, radius equal to AB and then transferring AB, the segment AE 

cut by the secant AO, on the circle. Let us now establish the relation that links 

the segments AB =a to AC =b and CB =c.  

          From (5) and a=b+c and consequently  
𝑏+𝑐

𝑏
=

𝑏

𝑐
⇔ (

𝑏

𝑐
)

2
−

𝑏

𝑐
− 1 =

0 , 𝑚𝑒𝑎𝑛𝑖𝑛𝑔 𝑡ℎ𝑒 𝑟𝑒𝑙𝑎𝑡𝑖𝑜𝑛(3). 
 One of the greatest qualities of the Greek architects was exactly that they 

expressed their aesthetic intuition through certain number ratios, for example 

the golden cut in the segments found in their buildings. Through their 

appearance, the Greek temples are classified in three orders: Doric, Ionic and 

Corinthic. Each of these orders have various proportions at the foot and the 

columns, the gables, etc.   
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In the temple of Poseidon, the god of the sea, 

which seems to have been built in the 6th 

century BC, we feel the power full of greatness, 

severity and life that the aspect of the columns 

release. Having a height of almost six times its 

diameter, its columns give the impression of 

some trees grown in the ground. Their base has 

no ornament and the necking has the shape of a 

swimbelt on which lies the stone slab that supports the down-shaped roof of the 

temple. This surrounds the necking which has the shape of an isosceles triangle. 

Through its hugeness, it reminds something from the Egyptian influence, 

although the feeling that its appearance brings is one of freshness and optimism.  

 

A different impression is the one inspired by the 

temple of Victoria on the Acropolis of Athens, 

belonging to the Ionic order. Its columns are even 

more ellegant than those of the temple of Poseidon. 

The ratio between their height and diameter is of 9 

to 1, meanining that the height of a column is 8 or 9 

times more than its diameter and that is why they 

seem more vivid. In fact, these columns do not come 

out directly from the ground but they stand on a 

pedestal made of three or even four overlapped cylindrical rings and the necking 

of the columns is adorned with two spiral-shaped  scrolls which remind about 

the shell of a snail. The roof leans against these scrolls. Everything shows 

wealth, ellegance and exuberance. Its columns are 10 times higher than its 

diameter and the neckings are adorned with acanthus leaves. To this geometry 

of the columns we must also add the series of calculations requires by the whole 

structure of the temple, calculations which derive from the ratio of the golden 

cut.  

 

The Corinthic order is even more greaceful because its columns are 

higher, ten times higher than its diameter, and the neckings are adorned with 

acanthus leaves. 
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The Parthenon, the temple dedicated to 

goddess Athena Parthenos, was built in the 

Doric style. The measurements done in the 

19th century showed that all the horizontal 

lines of the Parthenon are slightly thickened in 

the middle and thus the lines which seem 

horizontally straight are in fact convex curves 

and at the same time the walls and vertical 

edges are in fact concave curves.  

   The considerations about the proportions among the different component 

parts of a building did not limit the artist’s genius or freedom. The Greek 

architects were not the slaves of calculations. The made alterations so as to give 

harmony and ellegance to the building. Comparing the temple of Poseidon and 

that of Parthenon, one is bewildered by the difference between these two 

constructions, built in the same style.   

         

 

The Roman architects built one of the most 

amazing amphitheatres in the world: the 

Colosseum in Rome. It could hold, it is 

estimated, between 50,000 and 80,000 

spectators. The arena is eclipse-shaped, 

having the big axis of 200 m and the small 

axis of 167 m and the surrounding wall is 

cylinder-shaped, being made of 4 floors, all 

made of arcades. Each floor is built in a different style, meaning Doric, Ionic 

and Corinthic.  

     

Bibliography 

• Teoria Arhitecturii-Virgiliu Onofrei 

• http://www.arhitextdesign.ro 

• http://www.observatorulcultural.ro 
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Parabola, Paraboloid In Architecture 

Teacher: Zavaliche Tudorița 

”Gheorghe Cartianu” Technical High School, Romania 

 

Parabola is defined as a set of points in a plane that are equidistant from 

both the line and the point.   

The line d is called the directrix of the parabola while the point F is 

called the focus of the parabola.  

 
 

A  O  

( )yxM ,  

x  

y  

M   









− y

p
N ,

2
 









0,

2

p
F  

d  

 

Fig. 1. 

The parabola does not have a centre of symmetry but has an axis of 

symetry Ox . It is a plane curve.  

 

 Implicit Cartesian equations of the parabola: .   

Note: When 0x , the implicit Cartesian equation will become pxy 22 −= . 

 

 Explicit Cartesian equations of the parabola : pxy 2= , 0x , p 

being a positive point called the parameter of the parabola which shows its 

shape.  

 

pxy 22 =
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 The smaller p is, the closer Oy comes to the focus and directrix and the 

parabola gets closer to Ox axis (when 0→p  then the parabola degenerates in 

Ox axis). The bigger p is, the farther the focus and directrix get from the Oy axis 

and the parabola comes closer to the Oy axis (when →p then the parabola 

degenerates in the Oy axis).  

 

 Parametric equations of the parabola: 








=

=

ty

p

t
x

2

2

;   t      

 

 Hyperbolic paraboloid is the locus of the points M(x,y) in the plane 

which satisfy the equation:  

2 2

2 2
2 , , 0

x y
z a b

a b
− =   

 The hyperbolic paraboloid is a doubly ruled surface shaped like a saddle 

and i formed by doubly ruling a parabola that opens downward on a parabola 

that opens upward.  

 

 

y  

z  

x  

O  

     

 

 The hyperbolic paraboloid is used in industrial constructions as a 

roof pattern.  

 

 

 Elliptic paraboloid is the locus of the points M(x,y) in a plane which 

satisfy the equation: 
2 2

2 2
2 , , 0

x y
z a b

a b
+ =    
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y  

z  

x  

2  

  

1  

O  

 
 

Note: If a=b, then the elliptic paraboloid is circular around Oz, that means 

it can be generated through the rotation of a parabola of equation: 
2 22y a z=  

around the axis Oz. 
 

Parabolas and Paraboloids in architecture 

Parabolic arches are often used in architecture and construction 

engineering because they ensure the equilibrium of forces and thus the 

construcions are much more stable. 

 

 

Spring 24 in Olăneşti mountain resort 
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The Olympic Pool in Bacău 

 

Hulme Arch Bridge, Manchester, England 

Bibliography: ro.wikipedia.org 
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C.O.D.E in Maths Kick-off meeting in Łódź 

14-16.11.2018 

 

 

Day 1, 14.11.2018 

09.00 – 09.30 Welcome Coffee, signing list of participants etc. 

09.30 – 10.00 Presentation of the meeting agenda and other activities 

10.00 – 12.30 Management and Implementation of the Project 

12.30 – 13.30 Lunch 

14.00 – 16.00 Visit at the EC1 Science Center 

16.00 – 17.00 Day 1 conclusion 
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Day 2, 15.11.2018 

 

11.00 – 12.00 Presentation about the city in the Marshall’s Office of 

Lodzkie Region 

12.00 – 14.30 Discussions about the next steps of the Project (first students 

visit in Romania, partners responsibilities etc.) 

14.30 – 15.30 Visiting school and university building 

15.30 – 16.00 Day 2 conclusion 
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Young Architects - club from Romania 

 

 Our students built houses from recyclable materials. In addition to 

constructions, they also made light installations. They used Arduino for home 

automation. 

  

  



"The European Commission support for the production of this publication does not 
constitute an endorsement of the contents which reflects the views only of the 
authors, and the Commission cannot be held responsible for any use which may be 

made of the information contained therein." 
  

Page 25 
 

  

  



"The European Commission support for the production of this publication does not 
constitute an endorsement of the contents which reflects the views only of the 
authors, and the Commission cannot be held responsible for any use which may be 

made of the information contained therein." 
  

Page 26 
 

  

 

The "Christmas Era" regional competition - all members of the "Small 

Architects" team won the first prize. 
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SHORT-TERM EXCHANGES OF GROUPS OF PUPILS 

 

C1.Maths and Coding in Architecture 

14- 18 January 2019, Romania 

 

Days Activity 

13 

January 

2019 

Arrival 

14 

January 

2019 

Culture Fest 

Each partner school made a presentation about their educational 

system and how the informal education aiming at 14-18 year old 

students takes place in their countries according to legislative rules 

and administration. Presentations about school and country. 

15 

January 

2019 

Introduction of the challenge which was digitally visualized and 

design the home of students’ dreams was the challenge of the 

activity. Students visualized and planned their dream home with a 

realistic 3D home model. 

Mingled groups of students created the groups. There were 5 

corners where students performed team work. There were 

workshops and students created their own dream homes in a free 

access software platform. Students measured lengths and checked 

the results using the program. The 3D products surprised all 

students. 

They made round table meetings with their pairs and also decided 

what kind of homes they would create.  

They designed Home & Floor and a floor plan as a blueprint and 

then switched it to the 3D model. 

16 

January 

2019 

Study visit  

Designing Room & Interior 

There was a study visit at the University of BACAU, the Faculty 

of Engineering. Coding workshop were done and possible career 

paths were discussed. 

17 

January 

2019 

Designing Landscape & Garden 

The houses were presented by the group leader and the students 

voted the best product. They used Bitable to share.  

At the end students had the post-test which proved to be more 

demanding than the pre-test. 



"The European Commission support for the production of this publication does not 
constitute an endorsement of the contents which reflects the views only of the 
authors, and the Commission cannot be held responsible for any use which may be 

made of the information contained therein." 
  

Page 29 
 

18 

January 

2019 

The partner students participated at classes as teachers and they 

taught some traditional games and also some common phrases in 

their own language. In the meantime teachers evaluated the overall 

activity and discussed about the next mobility. Internal report was 

revised. 

- Digital Library (taking photos and videos during the program) 

with the creations and their posting on social networks. 

Evaluation 

Departure 

19 

January 

2018 

Departure 
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Visiting Piatra Neamt 

January 13, 2019 

 

We visited the city with the Spanish team and travelled by cable Gondola. 
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Culture Fest 

January 14, 2019 

 

Each partner school made a presentation about their educational system 

and how the informal education aiming at 14-18-year-old students takes place in 

their countries according to the legislative rules and administration. 

Presentations about schools and countries: Romania, Turkey, Poland, Italy 

and Spain. 
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Creating and designing houses from recyclable materials 

January 15, 2019 

 

Workshop - Creating and designing houses from recyclable 

materials: wood, cardboard, paper, boxes, etc. We made 2D sketches on paper 

and measured the perimeters, surfaces, lengths, etc. 
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Sweet Home 3D software 

 

Sweet Home 3D is a free interior design software that is used to draw the 

plan of a house, arrange furniture on it and visit the results in 3D. 

Sweet Home 3D user's guide:   www.sweethome3d.com/userGuide.jsp 
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Study visit at the University of BACAU, the Faculty of Engineering 

January 16, 2019 

 

”Vasile Alecsandri” University of Bacău is an important institution of the 

Romanian educational system.  The Faculty of Engineering was established by 

the Ministry of Education and Research in 1976 and now is part of the network 

of Romanian public technical universities.  

http://www.ub.ro/en/university/presentation 

http://www.ub.ro/inginerie/en/ 

 

 

 

 

http://www.ub.ro/en/university/presentation
http://www.ub.ro/inginerie/en/
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Visiting the Academic TV -youtu.be/Qy37Pg1XRt0. 

 

 

 

https://youtu.be/Qy37Pg1XRt0
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Visiting ”Gheorghe Cartianu” High School 

January 17, 2019 

 

 

 

 

Workshop guided by the Electronics and Robotics Team of the Neamt 

County Center with achievements in the STEM field 
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Evaluation of the CODING-based activities (post-test)  

"Deepening knowledge of coding" 

 

1.The furniture catalogue contains the categories: * 

 Bathroom 

 Bedroom 

 Door and Windows 

 Kitchen 

 Lights 

 Living room 

 Miscellaneous 

 Staircases 

2.To draw walls, you can use: * 
 Plan ->Create walls 

  
 select the Create walls tool 

 Edit->Create walls 

3.To draw dimensions, you can use: * 
 choose Plan -> Create dimensions 

  
 select the Create dimensions tool 

 choose Plan > Create length 

5.With what tools can you create different polylines, curves and 

polygons? * 
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 the tool in the figure 1  
 

 the tool in the figure 2  
 

 the tool in the figure 3  

 

6.Which category do the elements in the figure belong to? * 
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7. Which category do the elements in the figure belong to? *  

 
 

 
 

8. Which category do the elements in the figure belong to? *  
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9. Which category do the elements in the figure belong to? * 

 

 
 

10. Which category do the elements in the figure belong to? * 
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11. Which category do the elements in the figure belong to? * 
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12. Which category do the elements in the figure belong to? *  
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13. Which category do the elements in the figure belong to? * 

 

 
 

14.With Sweet Home 3D software can you create: * 
 homes 

 walls 

 furniture 

 gardens 
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15. Each Sweet Home 3D window edits the interior design of a 

home and is divided in four resizable panels, described as follows. * 

 

 
 

16.To transfer focus to another panel, you can use: * 
 TAB keys 

 SHIFT key 

 ALT key 

 click in the panel 
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17. When Aerial view is selected, the 3D view is always centered at 

the .......... of the set of walls, rooms and furniture. LeftRightCenter * 
 Left 

 Right 

 Center 

 Justify 

 

18. The floor default size of a new home is: * 
 5 by 5 meters. 

 10 by 10 meters. 

 20 by 20 meters. 

 

19. To create a home, simply use the default empty document 

created at Sweet Home 3D launch, choose: * 
 File ->New from demo 

 CTRL+T 

 CTRL+N 

 File-> New 

 

20.What extension do the files created with the Sweet Home 3D 

program have? *  
 .sh0d 

 .sh3d 

 .so3d 

 .se3d 
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21.If s = 3, what is the area of the square? * 

 
 6 

 12 

 9 

 3 

22.If l = 8 and w=5, what is the perimeter of the rectangle? * 

 
 40 

 16 

 10 

 26 
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23.If a = 6, b=6, c=6 what is the perimeter of the triangle? * 

 
 6 

 12 

 18 

 36 

 

24.What is the perimeter of the shape? * 

 
 481 

 532 

 430 

 397 
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25.What is the area of the shape? * 

 
 19280 

 15270 

 22750 

 13450 

 

Statistics 
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Presenting the home in a Biteable film 

( https://biteable.com/) 

Biteable, the power of video,  helps us to create professional videos in 

minutes. We can create a video from scratch by using our broad library of 

animations and footage. Biteable can be used to make ads, explainers, and 

social media videos. 

Here are some examples which were created by our students: 

https://biteable.com/watch/the-dreams-tower-2132919/ 

https://biteable.com/watch/the-best-day-2132911/ 

https://biteable.com/watch/my-home-2132908/ 

https://biteable.com/watch/real-estate-ad-copy-2132462/ 

https://biteable.com/watch/my-future-house-2132140/ 

https://biteable.com/watch/chiara-cipollone-3-2132104/ 

https://biteable.com/watch/my-home-2132114/ 

https://biteable.com/watch/home-presentation-2132100/ 

https://biteable.com/watch/my-home-2132069/ 

https://biteable.com/watch/my-home-2132088/ 

https://biteable.com/watch/future-home-2132079/ 

https://biteable.com/watch/house-building-2132096/ 

https://biteable.com/watch/lorenzo-torquato-2132092/ 

https://biteable.com/watch/future-home-2132079/ 

https://biteable.com/watch/travel-2132066/ 

https://biteable.com/watch/my-home-2132065/ 

https://biteable.com/watch/the-home-2132050/ 

https://biteable.com/watch/sweathome-2132030/ 

https://biteable.com/watch/take-2131997/ 

https://biteable.com/watch/sevval-2131996/ 

https://biteable.com/watch/beyza-2132012/ 

https://biteable.com/watch/accountant-ad-copy-2131994/ 

https://biteable.com/
https://biteable.com/watch/the-best-day-2132911/
https://biteable.com/watch/the-best-day-2132911/
https://biteable.com/watch/the-best-day-2132911/
https://biteable.com/watch/the-best-day-2132911/
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Romanian traditional dinner  

at "Colibele Haiducilor" restaurant 
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Educational activities 

January 18, 2019 

 

• Teachers’ and students’ participation at classes 

• Learning the expressions of daily speech in their own language 
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Painting workshop 

 

Visit of the painting workshop from our school coordinated by Ciprian 

Istrate, president of The ERA Cultural Association. 
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Evaluation of activities  

ceremony of awarding certificates of participation 

 

 

 

 

 

https://codeinmaths.weebly.com/uploads/1/2/2/1/122112933/foto-grup_orig.jpg
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Essay contest BE THE NEXT INVENTOR 

The use of robotics in medicine 

Student: Bădîngă Alexandru Nicolae  

 

As robots begin to mingle more and more in modern medicine, I can 

assure you it is not much until they will do most (or even all) of our work. We 

already use robotics to our advantage: from devices that can detect cancerous 

cells, to machines that are operated remotely by surgeons and even nanorobots. 

We currently lack the all-in-one version, but when we will have it, we can 

say (to a large extent) goodbye to the need of human workers in medicine. 

Imagine a world in which the long doctor checkup will be replaced by a 

few seconds, with instant results. After a few years of development, we might 

even have a "pocket doctor". The idea may seem a little far-fetched, but that is 

exactly what happened in the last decade in IT (we have come to have 

processors with huge computing power, smaller than a cent, an idea that seemed 

impossible in the 70’s-80’s). 

We do not have to think of robots as simple “wheel and arm” machines 

that make weird sounds when they move. Robots are actually defined as 

"automated systems" of any shape, form or size. We can even make a hospital-

size robot if we want, everything inside being automated. 

You might ask yourselves, what properties should a super-medical-robot 

have?  

Obviously, it should be able to do most things a doctor, psychologist, 

assistant, pharmacist, surgeon (etc.) can do. It should be fast and efficient, we 

can even make it power efficient by using clean energy. 

I can give some examples of things such a robot can do, but truly the sky 

is the limit. 

He could: 

-do instant checkups and provide instant results. He can dispense a wide 

range pharmaceutical products, he can even suggest lifestyle or diet changes 

that would benefit the user 

-promptly answer all questions, having the largest medical knowledge 

library in the world 
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- be able to do surgical operations safe and fast, cleaning and nursing all 

by himself, offering hospitalization in nearby sterilized rooms 

Ideas are easy to state, but harder to implement, because of both financial 

needs or even moral implications that can arise from such a big project and the 

limited technology of today.  

However, we can always hope for a better tomorrow, we will succeed 

sooner or later to make ourselves an easier and better way of life! 

 

Robotics 

 
Student: Grădinaru Nicoleta Daniela 

 

  

 I think there is a lot of work to do in the field of robotics. Robotics is the 

science that deals with design, technology, and robot manufacturing. In this 

field, programming, electronics and mechanics are required. 

 To create a robot, you must first have a lot of patience. Often, if a single 

thread is not connected properly, the robot does not work. Proper assembly of 

the robot is essential to be able to move to the programming side. 

 If the program lacks only one character it may not work. Often the 

discovery of errors requires time and, again, patience. 

 Until now, I have developed with Arduino platform  such as: electric 

lights, a smart home, the Rico robot that can dance and I have checked the 

operation of several sensors. 

 I would like to invent a robot for people who feel alone to get rid of their 

sadness. 

 I want to create a robot for sick people to care for them. 

 In the future, when I have children, I would like a humanoid robot, a  

nanny  to care for my children. 

 I know it is hard to make a robot have human feelings or do some of 

people’s daily activities.  

 Although they are mistrustful, robotics will develop in the future to help 

mankind. 
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